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executive summary  The HP StorageWorks Rapid Restore for Lotus Domino solution is a quick and complete 
method of recovering Lotus Domino databases with minimal disruption to services. The 
solution uses snapclones as a source for recovery and automated offline backups. A 
snapclone is a complete physical point-in-time copy of a data volume. Snapclones can be 
used to perform an extremely rapid restoration of application environments. The Rapid 
Restore for Lotus Domino solution provides 24 x 7 application availability for users. 
Using HP StorageWorks Enterprise Volume Manager (EVM) V2.0D and HP StorageWorks 
Enterprise Virtual Array (EVA) V2.0, customers can create snapclones of their Lotus databases 
and resume full operation of their environment in minutes. By using the information in this 
solution, customers will be able to: 
• Create snapclones of the Lotus databases 
• Restore data from snapclones 
• Create scripts to implement automatic backups from snapclones 
• Back up from snapclones to tape 

The intended audience is made up of experienced Lotus Domino administrators who 
understand how to work with snapclones using array controllers. Performance testing 
provided numerous insights into the best ways to use snapclones with EVA for rapid recovery 
of Lotus Domino data.  
Administrators face lengthy delays when restoring a Lotus environment from tape. This 
solution, which is based on creating snapclones with EVM in a Storage Area Network (SAN)-
based configuration, reduces the restore time from hours to minutes and causes minimal 
disruption to Lotus users. These timesavings can be dramatic, as illustrated in Figure 1. 

   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
figure 1. 175-GB database with 10,000 users, 8,000 active 
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about snapshots 
and snapclones 

 With EVA, you can create fully allocated snapshots and snapshots that normalize into 
snapclones. The traditional snapshot requires that you reserve space equal to the size of the 
original active virtual disk (vdisk). Data is not written into this reserved space until necessary. 
As data changes in the original active vdisk, the original data is written to the snapshot.  
Snapclones are complete, physical, point-in-time copies of data volumes and are ideal for 
reducing I/O loads on the production volumes. These copies can be used for backups to 
tape, disk-based backup, or application testing and data mining that will not impact 
production data.  
Snapclones are snapshots that normalize into clones. A snapclone has the same properties as 
a snapshot, so it is instantly available. The normalization process of copying the data from the 
original LUN happens in the background. Similar to a snapshot, a snapclone can be instantly 
mounted or backed up to tape. However, with snapclones, after the normalization process is 
complete, you have an exact copy of the database or LUN you wanted to clone. This is 
especially useful for fast restores if a catastrophic failure happens. Snapclones can be taken 
in any redundancy level (Vraid 0, 1, or 5) and they do not require extensive 
advanced preparation. Long “re-sync” times are also eliminated with snapclones since a 
current clone copy can be available for use in moments rather than hours.  

features and 
benefits 

 This solution provides the following benefits to administrators: 
• Dramatically improved backup and restore times for Lotus Domino R5 mail databases 
• Best practices for maximizing Lotus Domino R5 availability during database recovery 

scenarios 
• Simplified implementation and management, including script examples 
• Investment protection by leveraging existing HP hardware and software supporting multiple 

configurations, and providing interoperability with future products 
• Automated task scheduling of backup activity with HP OpenView Storage Management 

Appliance software V2.0 
• Integration with third-party tape backup applications—specifically tested with VERITAS 

Backup Exec V8.6 

business needs 

 

 The Rapid Restore for Lotus Domino solution is best suited for the following types of 
environments: 
• Customers who require the highest level of availability for Lotus Domino environments 
• Centralized Lotus Domino environments with more than 5,000 mailboxes 
• Customers who have experienced significant costs as a result of downtime caused by 

database recovery 
• Customers whose current recovery methods are time-consuming and inaccurate 

solution overview   The Rapid Restore Solution for Lotus Domino R5 is a validated and fully integrated 
configuration that provides a clustered SAN-based backup and restore infrastructure for end-
to-end data protection. This solution leverages the capabilities of EVA V2, EVM V2.0D, and 
the HP StorageWorks Enterprise Backup Solution (EBS), as illustrated in Figure 2. 
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re 2 . Rapid Restore for Lotus Domino building blocks  

 following diagram illustrates the details of the solution. 
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  The Rapid Restore Solution for Lotus Domino R5 consists of these basic components: 
• Lotus Domino R5 

You can configure the Lotus Domino server on any Windows 2000 server and use a 
Microsoft Cluster Server (MSCS) configuration for improved application availability. This 
solution documents a four-node MCSC cluster on Windows 2000 Datacenter with SP3. 
(When using HP StorageWorks Secure Path V4.0 and HP StorageWorks Enterprise 
Volume Manager V2.0x, use Windows Service Pack 2. After you upgrade to Secure Path 
V4.0A, you can use Windows Service Pack 3. For more information about the Secure Path 
V4.0A release, contact LotusStorageSolutions@hp.com) 

• Enterprise Virtual Array V2  
The Lotus Domino mail and log databases are located on the Enterprise Virtual Array. 
Based on the HSV controller, EVA is a high-performance, high-capacity, and high-
availability “virtual” RAID storage solution that eliminates the time, space, and cost 
boundaries of traditional storage.  
 
By using snapclones as part of your backup and restore strategy, EVA can save Lotus 
Domino customers significant time. Administrators can mount the clone on a secondary 
server and perform tape backup operations offline, while the production Domino server is 
up and running. Administrators can also restore full databases by mounting the clone on 
the production server and using the snapclone as the new data volume.  

• Enterprise Volume Manager V2.0D  
Enterprise Volume Manager is browser-based storage management software that facilitates 
controller-based clone operations to make a block-to-block copy of a storage volume. With 
EVM, you can create, run, and manage automated storage replication jobs, as well as link 
them with external jobs. The snapclones are also created using EVM 2.0D scripts. 
 
You must have an EVM host agent on each database server to utilize controller-based 
database cloning. The HP OpenView Storage Management Appliance is the operating 
platform for EVM, which offloads the processing from the user host systems.  

• Enterprise Backup Solution (EBS)—optional  
EBS provides a consolidated backup infrastructure that includes multiple servers connected 
over a high-speed Fibre Channel SAN to centrally attached SCSI tape libraries. This 
solution includes the NSR N1200 network storage router and the MSL5026 SDLT Tape 
Library as the EBS components. 
 
EBS with VERITAS Backup Exec V8.6 provides SAN-based backup-and-restore operations 
for snapclone-based tape backups. You must use a SAN-attached backup configuration 
when using this solution for clone-based offline tape backups. An approved third-party 
backup application, with associated Lotus Domino agents and SAN agents, provides 
backup management. A separate backup host, with the backup application loaded and 
visible to the storage subsystem and the EBS components, is required. 

 

mailto:LotusStorageSolutions@hp.com
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best practices   • Traditional configuration rules apply when planning storage requirements for your Lotus 
Domino partitions. Use vraid 1 for mail database vdisks that have high read and write 
activity to balance the combination of reliability and performance. 

• If utilizing transactional logging with Lotus Domino, it is an HP best practice to use different 
disk groups for log files and data files. Using this strategy, the log files will always be 
located on different physical disks than the data files. 

• Keep log files on vdisks that have been configured using vraid 1 or vraid 1 because of 
heavy write activity and disk failure recovery concerns.  

• HP recommends that you set the protection level to a minimum of single redundancy in all 
disk groups. Plan on using as much space as the parent vdisk can hold, and if possible 
add two extra spindles for single redundancy.  

• If you are expecting very heavy user activity, use preferred paths whenever possible to 
direct I/O flow across both controllers. 

• EVM 2.0D Host Agent Release Notes recommend logging out of the backup host when 
running EVM scripts that mount volumes. When the volume is mounted, a confirmation 
window displays, prompting a restart of the server. You do not have to restart the server, 
but you must acknowledge the pop-up window. If you are logged out, the window does 
not display and you do not have to acknowledge it. By logging out, you can be sure that 
the script runs and is not waiting for you to respond to the window. (If you do not log out, 
you must answer the question in the window.) 

test environment 
 

 This section describes the baseline configuration and provides listings of the hardware and 
software components used in the solution. 

test configuration   Four ProLiant DL760 8-way servers were used as Lotus Domino R5 mail servers in a four-node 
MSCS cluster configuration. Each node had two FCA2101 (2-GB HBA) adapters, which were 
connected to the fabric switch network. A ProLiant DL360 was used as the backup server and 
hosted the backup application, VERITAS Backup Exec V8.6. The ProLiant DL360 also served 
as the domain controller for the environment. 
EVA V2 provided storage for the Lotus Domino environment in a 2C6D configuration, which 
includes two HSV110 controllers and six disk cabinets (48–72.8 GB 15k rpm disks) for a 
total of 3.5 TB for disk storage. An MSL5026 SDLT Tape Library provided tape backup and 
restore support. The fabric switch network consisted of two redundant 2/16 EL SAN switches, 
housed in the EVA cabinet for enhanced cable management. 
Two subnets were set up for the test environment: 
• One subnet served as the cluster heartbeat to allow communication between the cluster 

nodes on the main network. This subnet was set up as a private network and was 
dedicated to cluster communication.  

• The second subnet was configured as the public network and included the dual-NIC cluster 
nodes along with the backup server, Storage Management Appliance and applications, 
and the drivers.  
The four-node cluster configuration supports a simulated 40,000-user environment with an 
80% active user ratio. (With this ratio, 80% of the users are actively sending and receiving 
mail while the other 20% are subscribed users who are only receiving mail.) The four 
nodes were divided into 12 Lotus Domino partitions with three partitions per server and 
10,000 users per node. 

In the test environment, limited disk space was available for mail databases and clones. 
Therefore, to represent a real-world backup and restore scenario, only node 1 in the cluster 
was fully populated with mail and able to process a fully simulated workload. The other nodes 
in the cluster only routed and received mail messages. The actual tests were conducted on the 
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three partitions of node 1, which included 10,000 users.  
Of the 3.5 TB of total storage, 582 GB was used for the initial eight-disk default disk group 
required by EVA. The quorum disk, which is necessary for the cluster, was created in the 
default disk group on the array. The remaining disks were grouped into one disk group to 
distribute I/O across the maximum number of Fibre Channel disks for performance. Each mail 
database for users on node 1 was 50 MB with the following breakdown of mail messages: 
 

  table 1. example of one user’s mailbox on node 1 

number of 
messages 

size of message total storage 

1 5 MB 5 MB 
6 1 MB 6 MB 

10 500 KB 5 MB 
100 100 KB 10 MB 
300 50 KB 15 MB 

   
Total: 417  Total: 41 MB*  

  Notes: 
• *(what does this * reference?)The R5 mail template used to create the 50 MB mail 

databases is approximately 9 MB. 
• Users on the other three nodes in the cluster (users 10,001–40,000) have mail databases 

that are approximately 5 MB and only received mail. 
• Each partition on node 1 included 3,333 users (175 GB each) for a total of 10,000 users. 
• Each partition LUN, created with the HSV Element Manager, was 175 GB and configured 

as Vraid1.  
• Partitions 4–12 were much smaller Vraid1 LUNs at 20 GB each. 

  This document does not discuss Lotus Domino server performance or sizing considerations. 
Lotus Domino performance can be affected by a number of factors, such as the size and type 
of mail sent, the size of the mail databases, the volume of mail sent and received, and the 
type of mail routing. These factors directly impact processor, memory, and storage subsystem 
requirements.  
For a full, four-node implementation of 40,000 Lotus Domino users, you also need to consider 
the types of users that are supported. You will likely need additional disk space. Fortunately, 
with the virtualization and dynamic growth capabilities of EVA, you can easily add additional 
disks into the storage subsystem.  
Refer to the HP Active Answers Web site for more information on Lotus Domino server sizing, 
performance, and consolidation. 
www.hp.com/go/activeanswers/lotus  

hardware and software 
components 

 The following is a list of the hardware and software components used in the test configuration. 
Keep in mind that new versions of these components frequently become available and the 
listed parts may not be orderable. 

www.hp.com/go/activeanswers/lotus
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  table 2. hardware components 

  ProLiant Servers Hardware Part Number 

ProLiant DL760, Pentium III, 700 MHz, 8 
way 

(4) 177657-B21 

8 GB–2048 MB 100 MHz ECC SDRAM 
DIMMs Memory Expansion Kit (per server)

(16) 328809-B21 

36.4 GB Ultra 3, 15K rpm drives (4 per 
server) 

(16) 176496-B22 

FCA 2101 (LP952) HBA (8) 245299-B21 

Backup Server  

ProLiant DL360 server, Pentium III 1 GHz 
Processor 

233271-B21 

FCA 2101 (LP952) HBA (2) 245299-B21 

Management Appliance  

HP OpenView Storage Management 
Appliance II 

189715-002 

Primary Storage Hardware  

HP StorageWorks Enterprise Virtual Array 
– 2C6D-B 
42U M3220 Controller assembly with 
dual HSV110 controllers and 6 M5214 
dual fiber loop 14-bay drive enclosures 

283198-B21 

72 GB 10K rpm dual-port 2 Gb/sec FC-
AL 1-inch drive 

(48) 238921-001 

SAN/Network Infrastructure  

SAN Switch 2 GB/16 Port EL (2) 283056-B21 

5 m LC-LC Multi-Mode Fibre Channel 
Cable 

(16 221692-B22 

15 m LC-SC Multi-Mode Fibre Channel 
Cable 

(2) 221691-B23 

30 m LC-SC Multi-Mode Fibre Channel 
Cable 

221691-B26 

15 m LC-LC Multi-Mode Fibre Channel 
Cable 

221692-B23 

Secondary Storage Hardware  

NSR N1200 Network Storage Router (1) 280823-B21 

MSL5026SL RM SDLT Minilibrary (2 drives) 302512-B22 
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  table. 3. software components 

Software Part Number 

Windows 2000 Data Center with SP3 Third party 

Microsoft Cluster Server (MSCS) Included 

Lotus Domino R5 Third party 

HP OpenView Storage Management 
Appliance software V2.0 

QB-6M4AA-SH 
Requires download from Web site 

HP StorageWorks Secure Path V4.0A 
(5 licenses)1 

Available March 2003 or 
contact 

HP StorageWorks Enterprise Volume 
Manager V2.0D (Starter kit, 5 host 
licenses) 

WNT/W2K KIT V2.0 ENT VIR ARY 
(for Windows NT 4.0/2000) 

Snapshot License for VCS V2.0 Dual 
HSV Controllers up to  
3.1 TB 

VCS PKGV2.0 Dual HSV Controller 
(base controller software) 

Lotus Notes bench R5 mail workload 
generator 

VERITAS Backup Exec V8.6   

                                                      
1 When using HP StorageWorks Secure Path V4.0 and HP StorageWorks Enterprise V
2. After you upgrade to SecurePath V4.0A, you can use Windows Service Pack 3. For
contact LotusStorageSolutions@hp.com.  
LotusStorageSolutions@hp.com 
9 

263670-B22 

250195-B22 

253256-B22 

250203-B23 

Third party 

Third party 

olume Manager V2.0x, use Windows Service Pack 
 more information about Secure Path V4.0A, 

mailto:LotusStorageSolutions@hp.com
mailto:LotusStorageSolutions@hp.com
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performance results   A baseline EVA configuration was created with a full install and configuration of software in 
the Lotus Domino environment, including EVM V2.0D, Secure Path V4.0A, and HP OpenView 
Storage Management Appliance software V2.0. The following configurations were tested: 

  Test 1. Baseline with EVM  
An 8,000-user baseline test was run in the environment, which created a 37% CPU utilization 
on node 1 of the cluster. The load was generated on the cluster using the Lotus Notebench 
load-driving tool. The baseline test was then compared against other performance tests to 
determine the impact of creating a snapclone in the Lotus Domino environment. Performance 
numbers were collected using Windows Performance Monitor and Lotus Notebench. 
Results: 
Numerical results are displayed in Table 6, “Baseline and Snapclone Performance Results.”  
 
Test 2. Creating snapclones  
Creating snapclones with EVA uses available disk space in the disk group of the parent vdisk 
to create the vdisk copy. Using snapclones in this solution consumed 525 GB, including the 
mirrored data volume of 175 GB. By using Lotus Domino partitions, the size of the snapclones 
and normalization times were significantly reduced.  
 
The snapclone of partition 1 was created while it was offline. The remaining partitions were 
online. Partition 1 was brought online while the snapshot was normalizing into a snapclone in 
the background. Since the snapclone has the same properties as a snapshot, the snapclone of 
partition 1 was instantly available. When the normalization process was completed, an exact 
copy of the partition that was being cloned was ready for use.  
 
Results: 
Snapclone creation took about two minutes, which includes the one minute it took to stop and 
start the Lotus Domino cluster task under no load, and the one minute it took to create the 
initial snapshot. Without partitions, the snapclones would have been three times larger, and 
three times as many users would have been affected when the server was brought offline to 
initiate the snapclone. However, one factor to consider is the time to start and stop the server, 
which increases as the number of users that are currently connected increases.  

  Table 4 shows the snapclone building times for different size partition volumes. 
  table 4. snapclone building times 

LUN Size/Type Normalization Time 
without Load 

Normalization Time 
with Load 

20-GB Data 17 min N/A 
175-GB Data 128 min 224 min  

  There was slight performance degradation on the server under test while the snapclone was 
normalizing in the background. The delay caused by creating the snapclone resulted in an 
increase of disk queues on the server and a decrease of CPU utilization. However, this testing 
was performed under a heavy load to maximize the negative impact that can occur when 
creating a snapclone. There also was an active/subscribed user ratio of 80% and 8,000 
users were driving load against the server. The impact will vary depending on the load in the 
customer environment.  
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  Test 3. Backing up to tape  
For comparison purposes, a tape backup was made of Lotus Domino partition 1, which was 
offline for the duration of the backup. The remaining partitions were online. The time it took to 
create the tape backup was compared to the amount of time it took to create a snapclone.  
Results:  
The time to perform a full tape backup of the Lotus Domino partition was 6 hours and 
21 minutes, or five times longer than the time needed to normalize the snapclone (under no 
load during off hours) and about 190 times longer than the time needed to create the 
snapclone. 
The 6-hour 21-minute backup window includes the time needed to verify the backup upon 
completion, which was about 2 hours and 10 minutes. This time ensures that the tape backup 
is readable and uncorrupted and is recommended when performing tape backups. 
Note:  
As an alternative, you can also use VERITAS Backup Exec V8.6 to perform tape backups 
while the server is online by using Lotus Domino agents residing on the server. This is a 
recommended approach for limiting server downtime.   
Online backups have minimal effect on Lotus Domino performance but are an inefficient 
method for frequent backups because of the time required for completion and the potential 
conflict with user activity. Performing tape backups while the server is offline is inefficient, 
even when conducted during off hours. Snapclones provide limited server downtime and 
impact on the user.  
 
Test 4. Restore Operations  
With snapclones as your restore method, you can use the Windows drag and copy functions 
to restore particular databases or to mount the entire snapclone as the new data volume. You 
can also restore the entire data volume by unpresenting the corrupted vdisk and presenting 
the snapclone data volume to the server and cluster. This is described in detail later in this 
document. 
Although you can restore Lotus Domino databases from a tape backup, it is an inefficient 
method since the server must be down for extended periods of time.  
 
Results:  
The use of snapclones with EVA and EVM proves to be the fastest and most reliable means of 
restoring Lotus Domino databases. See Table 5. 
 

  table 5. time required for different restore methods 

Lotus Domino restore method time (hrs) 

Lotus Domino Snapclone Restore 15 min 
Windows File Drag and Copy Dependent on size of 

database 
Lotus Domino Tape Restore 6 hrs and 2 min  
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  table 6. baseline and snapclone performance results 

 baseline 
with EVM 

creating 
snapclones 

User Connections 8000 8000 
Benchmark Profile R5 mail  R5 mail 
Length of Test (steady state) 5 hrs 6 hrs 
Database downtime n/a 2 min 
Processor Time (%) 37.1 29.7 
Process % CPU Time – 
nserver 

67.3 58.8 

Process % CPU Time – 
nrouter 

29.1 24.4 

Available Bytes (MB) 1350 1238 
Pages/Sec 2928 2740 
Avg. Disk Queue Length 7.2 12.3 
Avg Disk Sec/read .015 .025 
Avg Disk Sec/write .007 .014 
Current Disk Queue Length 7.3 12.02 
Disk reads/sec 395.3 385 
Disk writes/sec 191.3 187.7  
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solution setup and 
installation 
instructions 

 Caution: Many of the commands and procedures described require Lotus Domino and 
Windows administrator privileges and could disrupt operations if used incorrectly. If you are 
not familiar with these commands and functions, consult your Lotus Domino and Windows 
Datacenter documentation before proceeding. As with any changes to your Lotus Domino 
configuration or backup plan, be sure to test these changes thoroughly before implementing 
them in a production environment. 
The following components must be installed and configured before implementing this solution 
(shown in proper order of installation): 
• Set up the Storage Area Network with the following components: 
� HP OpenView Storage Management Appliance software V2.0 
� HSV Element Manager V2 
� Snapshot licenses for HSV V2 controllers 
� EVM V2.0D Server 
� HP StorageWorks Secure Path Manager V4.0A  

(When using HP StorageWorks Secure Path V4.0 and HP StorageWorks Enterprise Volume Manager 
V2.0x, use Windows Service Pack 2. After you upgrade to SecurePath V4.0A, you can use Windows 
Service Pack 3. For more information about Secure Path V4.0A, contact 
LotusStorageSolutions@hp.com.) 

� Enterprise Virtual Array V2  
• Create and configure necessary disk groups. This will include the quorum vdisk that was 

created on the default disk group along with the 12 Lotus Domino partition data LUNs in 
their own separate disk group. In a customer environment, HP recommends splitting 
transaction logs from the data files across multiple disk groups to spread out I/O across 
spindles. 

• Set up the servers appropriately: 
� Dual NICs for network connectivity (cluster heartbeat and public network) 
� FC2101 HBAs 
� Windows 2000 Kit for EVA V2 
� EVM 2.0D Host Agent for Windows 2000 
� Secure Path V4.0A server on hosts 

One subnet will be used as the private cluster heartbeat to allow communication between the 
cluster nodes off the main network. The second subnet is configured for the public network 
and includes the dual-NIC cluster nodes along with the backup server, the Storage 
Management Appliance and applications, along with the client and parent test drivers to 
drive the test. 

• Connect SAN components: 
� Connect hosts to the SAN switch. 
� Add host connections to hosts folder on the HSV Element Manager. 
� Present vdisks to Node 1 (cluster quorum disk and 12 Lotus Domino data partitions) 

i. For best results and to avoid data corruption, power down nodes 2, 3, and 4 while presenting 
the vdisks to host 1. 

ii. Perform a full format on all the basic disks (quorum and 12 data LUNs). 

iii. Power down node 1 and power on node 2. Present LUNs to node 2 and ensure that the logical 
drives are visible and that the drive letters match those from node 1. To add LUNs as cluster 
resources, each host must see them as the same drive letter. 

iv. Repeat step iii for each node, until the LUNs have been presented to every node in the cluster.  

v. Power down node 4 and turn on node 1 in preparation for MSCS cluster installation. 

 

mailto:LotusStorageSolutions@hp.com
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  • Set up the cluster and Lotus Domino. 
  
Step-by-Step Guide to Installing Cluster Services: 
www.microsoft.com/windows2000/techinfo/planning/server/clustersteps.asp 

Install MSCS. Choose Start > Control Panel > Add/Remove Programs > Add/Remove 
Windows Components on the first node.  
 
Install Lotus Domino in a clustered environment.  
 
Lotus Domino partition install for high-availability cluster solution: 
http://activeanswers.compaq.com/ActiveAnswers/Render/1,1027,367-6-100-225-1,00.htm

  • Configure Secure Path and EVM. 
 
Note: For naming purposes, add an entry in your DNS table for the Storage Management 
Appliance. 
a. Configure the Secure Path logon and client table on each host. Select  

Start > Programs > Secure Path > SecurePathCfg. 
1. Set a common password that Secure Path Manager will use to poll each client machine. 
2. If the client is a cluster member, in the Clients Configuration Table (in no particular order), add 

the name of the Storage Management Appliance, and then enter the cluster node name for 
each Secure Path client followed by the cluster name as follows: node_name:cluster_name. 

3. If the client is not a member of the cluster, then just add the host name and the Storage 
Management Appliance names in the Client Config Table. 

4. From the Storage Management Appliance, start Secure Path from the Network Utilities folder 
and create a profile. Add the name, password, and each host as they were listed in the Client 
Config Table and save the profile.  

 

  b. Configure EVM. 
Important: Read EVM 2.0D Server and Host Agent Release Notes before configuring EVM. 
There are configuration limitations that must be acknowledged in order for the EVM 
configuration to work. 

1. Install EVM host agents on all client machines and choose the cluster option for all cluster 
nodes. 

2. From the Storage Management Appliance, use Windows Explorer and select Start > 
Program Files > HP > SANworks > Enterprise Volume Manager > bin > hosts. 

3. Make sure you see all your host and cluster entries in the hosts folder. There should be a .HST 
and .VOL file for each host in your EVM network. 

4. Initially after the EVM Switchboard service is restarted (on the client machines), the EVM Server 
will acquire the information from the host machines and there will be a .DATA file in the hosts 
folder. After all the data from the hosts has been collected, the .DATA files will disappear. 

5. Start EVM from the Volume Management folder. 
6. Under the Resources tab, your hosts and cluster should display in the top view pane and the 

HSV subsystem should display in the bottom view pane. If the Resources window hangs, EVM 
might not be able to log on to the HSV subsystem. 

7. To verify that EVM is using the correct logon, open up the evm.cfg file in the EVM bin folder 
and verify the correct Storage ID and Storage Password. If either is incorrect, make the 
appropriate changes and restart the Switchboard service on the Storage Management 
Appliance. The ID and password should match that of the Storage Management Appliance 
logon. 

 
 

www.microsoft.com/windows2000/techinfo/planning/server/clustersteps.asp
http://activeanswers.compaq.com/ActiveAnswers/Render/1,1027,367-6-100-225-1,00.htm
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working with EVM  This section describes how to perform the following tasks: 
• Preparing to back up and restore the Lotus Domino partition 
• Creating snapclones with EVM 
• Cleaning up EVM jobs 
• Backing up to tape 
• Restoring Lotus Domino using snapclones  

preparing to back up 
and restore 

 By design, Lotus Domino partitions allow corporations to spread users over multiple data 
directories on one server. In this way, when you perform backup and restore operations, a 
single partition can be taken offline without impacting the rest of the users on the server. 
Because of this functionality, this rapid restore solution focuses on creating snapclones of one 
partition at a time, which minimizes the impact of downtime on the end users.  
A batch script was written that brings the cluster service task offline and stops the Lotus 
Domino partition. This is a graceful shutdown, which minimizes the number of database 
consistency checks that are required when the partition restarts. Another batch file was written 
that starts the cluster service task and the Lotus Domino partition. 
The following two files were used to start and stop partition 1 on node 1. 
 
start.bat stop.bat 

 
When you work with clusters and EVM, there are some special access considerations that you 
need to keep in mind. When you start and stop the Lotus Domino partition, you must access 
the cluster resource task, and not just the Window NT service task. You must run the EVM 
switchboard service from an account that has access rights to cluster administration. To 
enable the account to access the cluster, follow these steps: 

1 Select Start > Programs > Administrative Tools > Services. 
2 Right-click the Switchboard service task and select Properties. 
3 Select the Logon tab. 
4 Select an account to run the switchboard service that has administrative service to the 

cluster. 
5 Select Programs > Administrative Tools > Cluster Administrator and then 

right-click the name of the cluster. 
6 Select Properties > Security and then add access for the account that is running 

the switchboard service. 
HP recommends that backup operations take place during off hours and overnight when 
utilization is lowest to further reduce end user impact. 

cluster domino-eva res "Lotus Domino Server 
(DOMINOPARTITION4)" /on 

cluster domino-eva res "Lotus Domino Server 
(DOMINOPARTITION4)" /off 
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creating snapclones with 
EVM 

 Snapclones can be created with EVM 2.0D and EVA to guarantee safe data storage. After 
opening EVM, create a new job name and owner in the New Job window. Be sure to include 
comments in your scripts to let others know the purpose of the commands. The EVM 
commands are listed in the left side of the New Job window. The most common commands 
are SUSPEND, SNAP, RESUME, MOUNT, and UNDO. In this solution, the LAUNCH and 
DELAY commands are also used. 
The following EVM command sequence was used in this solution: 
• SUSPEND — The first command in the job, the SUSPEND command calls the stop.bat file 

that stops and shuts down the Lotus Domino partition.  
• SNAP — The SNAP command is the command available to replicate volumes on an EVA. 

Within the SNAP command are options for the type of snapshot for the job. For this 
solution, the SNAPCLONE snap option was used. 

• RESUME — After the SNAP process has completed, the RESUME command must be run to 
call the start.bat file to start the Lotus Domino partition. 

• MOUNT — When the volumes have been replicated, the snapclone can be mounted on a 
backup host for tape backup or an offline server for test purposes. 

• DELAY — The DELAY command provides time in seconds for the Windows host to 
recognize the new volumes. 

• LAUNCH — The LAUNCH command starts a backup to tape using the backup 
application’s command line utility.  

  

 
  figure 4. sample EVM script 
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  This EVM job shuts down the Lotus Domino partition, takes a snapclone of the partition data 
volume, mounts the snapclone to a backup host, starts the Lotus Domino partition, and then 
launches a backup job to tape. The same job can be modified to create a snapclone and 
subsequent tape backup of any partition by changing the start.bat and stop.bat files to point 
to the appropriate partition and by issuing the SNAP command on the new data volume.  
Note:  
If there is an EVA hardware failure during the period when the snapclone is building or 
normalizing, the snapclone data can become corrupt or lost. 
Best Practice: EVM 2.0D Host Agent Release Notes recommend logging out of the backup 
host when running EVM scripts that mount volumes.  
 

cleaning up EVM jobs  EVM jobs must be recycled to keep the job list as clean as possible, so it will be easier to 
manage job schedules and perform restore operations in the fastest amount of time. To 
minimize the number of EVM jobs in the job list, create, save, and schedule only the number 
of jobs needed to have two copies of the Lotus Domino partition constantly available. After 
you have created the jobs, you can schedule them to run so that the first job is deleted before 
it is scheduled to run again. See the “Sample backup plan” section.  
 
To undo an EVM job: 
 

1 Click the Job Status tab. 
2 Right-click the job name and click UNDO. 

 
After the UNDO completes, you can run the job again to create another copy.  
 
Caution: If you use the snapclones for a restore operation and the snapclones are running as 
the recovered partition, do not click UNDO. If you run UNDO while the snapclones are 
running, you will lose the partition. See the “Restoring Lotus Domino server using snapclones” 
section for more information. 
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backing up to tape  Tape backup remains an integral part of the backup process and VERITAS Backup Exec V8.6 
was the tape backup application for this solution. VERITAS Backup Exec was installed on the 
backup server to manage the tape backup and restore operations for the environment. Lotus 
Domino Data Agents were also installed on each Lotus Domino server running in the four-node 
cluster. 
 
Along with VERITAS Backup Exec v8.6, the Backup Exec Command Line Applet was installed 
and can be utilized to perform many Backup Exec functions from a DOS prompt. The 
Command Line Applet can be used to launch a backup operation from the command line with 
switch parameters or by calling a predefined script file containing the backup job variables.  
With EVM, you can execute a batch file on the backup server that initiates a tape backup of 
the clone that was just previously mounted. The following command was used in testing to 
generate a backup of the cloned partition and call a script file for the backup variables: 

 
CD "\Program Files\Veritas\Backup Exec\NT" 
bemcmd -o90 -f"F:\eva testing\scripts\backuptest.txt" 

 
The following is an example of the script file that is run by the Command Line Applet for 
Backup Exec. Several bolded groups with different variable options are used for the backup.  
Notes:  

• All the options are not displayed in this script. For further information about the 
parameters for Backup Exec Command Line Applet scripting, read the VERITAS 
Backup Exec for Windows NT and Windows 2000 Administrator’s Guide.  

• The backup path under SELECTIONS must be the same as the directory that the EVM 
script references to mount the clone. 
 
 
[General] 
 
JOB_TYPE=Backup 
JOB_NAME=Testscriptedbackup1 
 
[Backup_Options] 
 
BK_METHOD=0 
DEVICE_NAME=Shared Storage Drives 
OVERWRITE_JOB=no 
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  [Media_Options] 
 
MEDIA_NAME=test scripted backup 
MEDIA_SET=Media Set 1 
APPEND=yes 
APPEND_NO_OVERWRITE=yes 
VERIFY=yes 
COMPRESSION_TYPE=0 
CHECKSUM=yes 
EJECT_MEDIA=yes 

 
[Miscellaneous] 
 
 [Schedule] 
 
RUN_IMMEDIATE=yes 
 
[W2K] 
 
BACKUP_LOCAL_MOUNT_POINTS=yes 
 
[Selections] 
 
PATH1=T:\Domino\*.* 
INCLUDE1=yes 
SUBDIRS1=yes 
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sample backup plan  A solid backup plan is the key ingredient to successful recovery in the event of a Lotus Domino 
disaster. The backup plan depends on the Lotus Domino administrator and the operating 
environment. HP recommends keeping a minimum of two clones available at all times and 
cycling every 48 hours. With this approach, disks recycle automatically and provide rapid 
restoration for up to 48 hours. Here is a sample backup plan: 
Monday   Tuesday    Wednesday   
Undo Clonejob1   Undo Clonejob2   Undo CloneJob1   
Run Clonejob1    Run Clonejob2   Run Clonejob1 
Tape backup optional  Tape backup optional  Tape backup optional 
Log backups throughout day Log backups throughout day Log backups throughout day 
 
Thursday    Friday    Saturday 
Undo Clonejob2   Undo Clonejob1   Undo CloneJob2   
Run Clonejob2    Run Clonejob1   Run Clonejob2 
Tape backup optional  Tape backup optional  Tape backup optional 
Log backups throughout day Log backups throughout day Log backups throughout day 
 
Sunday 
Full tape backup of Lotus Domino databases 

 
Keep in mind that this backup strategy is sufficient for only one partition in the environment 
and that this must be applied to each partition for full disaster recovery and rapid restoration. 
Available snapclones can also be used in the following ways: 
• As a backup for the Lotus Domino databases 
• To run offline testing or analysis 

restoring Lotus Domino 
server using snapclones 

 This section describes how to use a snapclone to quickly restore a Lotus Domino partition and 
databases. The restore scenario varies depending on the type of transactional logging that is 
enabled on the server.  
Restore options include: 
• With transaction logging disabled, a snapclone can only be used to restore to the point in 

time when the snapclone was created.  
• If circular logging is enabled and there is a clone of the log or the log file is uncorrupted, 

then the snapclone can be restored and the log will be applied automatically to update the 
server.  

• If archive logging is enabled, then third party backup software compatible with the R5 API 
(VERITAS Backup Exec V8.6) is necessary to “roll forward” the log files and apply the 
changes since the last tape backup of the mounted snapclone and archived logs. Keep in 
mind that you can also perform a full restore of the databases from tape backups. This 
option is best when time is not an issue.  
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  Scenario: Lotus Domino partition disk has crashed and circular transaction logs are intact or 
the cloned transaction logs are current. You decide to restore the databases from a 
snapclone.  

1 Back up transaction logs. 
2 Stop the Lotus Domino cluster service by taking the service offline using Cluster 

Administrator. 
3 Remove physical disk volumes as Lotus Domino service dependencies in Cluster 

Administrator and delete the physical disk resource. 
4 Swap the corrupt disk with the snapclone volume by unpresenting the volume using 

the HSV Element Manager on the Storage Management Appliance. Open the corrupt 
active vdisk and click the Unpresent tab. Unpresent the corrupt active disks from the 
cluster nodes.  

5 To present the snapclone to the cluster hosts, open the snapclone active vdisk and 
click the Present tab. Select the cluster nodes one at a time. 

6 Change the drive letter on the new volume to reflect the drive letter of the original 
database volume using Computer Manager – Disk Management. (In cluster 
configurations, the fastest way to restore the Lotus Domino partition disks is to use the 
same drive letters as the original disks.) 

7 If the transaction logs are intact, then retain the original log disk and mount the 
snapclone of the Lotus Domino partition directory (.nsf files). If the transaction logs are 
damaged, go back to step 4 to swap the snapclone of the log files. 

8 Add the snapclone volume as a cluster resource and Lotus Domino cluster 
dependency. 

9 Start the Lotus Domino cluster service. 
10 Once the partition starts, the transaction logs will be applied automatically. 
11 Go back to EVM. On the Job Status screen, delete the job that originally created 

the snapclone. It is important that you delete this job so that it can never be undone.  
 
Caution: Clicking UNDO will delete the volumes and you will lose your database.  
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  This process can be repeated for each partition that needs to be restored and can be run 

separately or concurrently. Figure 5 shows the Lotus Domino partition cluster resources. 
 

  

  figure 5. cluster administrator  
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related solutions  For Lotus solutions for storage and servers: 
www.hp.com/solutions/lotus 
www.hp.com/go/activeanswers/lotus  
 

for more 
information  

 For more on the HP StorageWorks Rapid Restore for Lotus Domino Solution: 
http://h18006.www1.hp.com/storage/solutions/application.html 
 
For HP Lotus Solutions for Industry Standard Servers: 
www.hp.com/solutions/lotus 
www.hp.com/go/activeanswers/lotus . 
 
For information about Lotus Domino 
http://www.lotus.com/products/r5web.nsf/webhome/nr5serverhp-new 

 
For HP StorageWorks Enterprise Virtual Array information and documentation: 
http://h18000.www1.hp.com/products/storageworks/enterprise/index.html 
 
For HP OpenView Storage Management Appliance information and documentation: 
http://h18000.www1.hp.com/products/sanworks/managementappliance/index.html 
 
For HP StorageWorks Enterprise Volume Manager documentation: 
http://h18000.www1.hp.com/products/sanworks/evm/index.html 
 
For EVM integration with Enterprise Backup Solutions, including VERITAS Backup Exec: 
http://h18000.www1.hp.com/products/storageworks/ebs/documentation.html 
 
For HP StorageWorks Secure Path information and documentation:  
http://h18000.www1.hp.com/products/sanworks/secure-path/documentation.html 
 
For VERITAS Backup Exec information and documentation: 
http://www.veritas.com/products/category/ProductDetail.jhtml?productId=bews 
 

  All brand names are trademarks of their respective owners. 

Technical information in this document is subject to change without notice. 

© 2003 Hewlett-Packard Company 
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